
S-EA-T User Guide 

 

1 

 

 

Simple Enterprise 

Architecture Toolset 

(S-EA-T) Academic Version 
 

 

 

 
May 2010 



S-EA-T User Guide 

 

2 

 

Revision History 
 

Name Date Reason For Changes Version 

J.Jordan 04/05/2010 Document Created / Populated 0.01 

D.Banger 25/05/2010 Document Content updated  0.02 

D.Banger 30/05/2010 Final Updates / Released 0.1 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Copyright Notice: 

© Copyright 2010 S-E-A-T.COM (UK) Limited.  All rights reserved. 

You may photocopy or print this document only for your own or academic use.  You may not 

resell or distribute this document in any form – printed or electronic – without the express 

permission of the publisher.  You may not link directly to this document without the express 

permission of the publisher.  You may however, provide a link to any page in the publisher’s 

website (www.s-ea-t.com) to allow the document to be downloaded from there.   

 

This document is provided free of charge to clients and academic institutions, and is 

provided without any warranty of any kind.  S-E-A-T.Com Limited and its partner White 

Knight Management Ltd accepts no liability for any loss or damages resulting from the use of 

this document or any of the information or opinions it contains 

http://www.s-ea-t.com/
http://www.whiteknight.it/
http://www.whiteknight.it/


S-EA-T User Guide 

 

3 

 

Contents 
 

Revision History ....................................................................................................... 2 

Contents ................................................................................................................. 3 

Installing S-EA-T ...................................................................................................... 5 

Getting Started with S-EA-T ....................................................................................... 6 

Understanding the User Interface ............................................................................ 6 

The Grid ............................................................................................................... 6 

Moving from Current through Transitional to Target ................................................ 7 

Understanding the Red-Amber-Green (RAG) key ..................................................... 7 

Navigating S-EA-T ................................................................................................. 7 

Moving around the views ..................................................................................... 7 

Returning to the grid ........................................................................................... 7 

The View Options ................................................................................................ 8 

Managing Projects ................................................................................................. 8 

Creating a new Project ........................................................................................ 8 

Opening an existing Project .................................................................................. 8 

Working with the Sample Project .......................................................................... 8 

Saving your work .................................................................................................. 8 

Printing items ........................................................................................................ 8 

Registering S-EA-T ................................................................................................ 8 

Working with Basic items......................................................................................... 10 

Managing Architectural Principles ........................................................................... 10 

Managing Stakeholders ........................................................................................ 11 

Managing Strategic Themes .................................................................................. 12 

Managing Standards ............................................................................................ 14 

Managing Policies ................................................................................................ 15 

Managing Service Catalogues ................................................................................ 16 

Working with the Business Operating Model ............................................................... 18 

Understanding the BOM ........................................................................................ 18 

Working with items of Organisational Context? ........................................................ 18 

Adding a Driver ................................................................................................ 19 

Adding a Business Unit ...................................................................................... 19 

Adding Notes .................................................................................................... 20 

Changing colours in the BOM................................................................................. 21 

Working with Artefacts ......................................................................................... 22 

Working with Resources ..................................................................................... 22 

Working with Assets .......................................................................................... 24 

Working with Consultations ................................................................................ 25 

Working with items of Information ...................................................................... 25 

Displaying BOM traceability ................................................................................... 26 

Working with Business Processes .............................................................................. 27 

Working with items of Process Context ................................................................... 27 



S-EA-T User Guide 

 

4 

 

Defining BPCM items ......................................................................................... 27 

Working with Processes ........................................................................................ 28 

Adding a Sub Process ........................................................................................... 31 

Working with the Application Portfolio ....................................................................... 33 

Adding an application to the portfolio ..................................................................... 33 

Assigning further information to an application ........................................................ 34 

Adding an Operational Store ................................................................................. 35 

Working with the Data and Information View ............................................................. 37 

Working with items of Data & Information Context................................................... 37 

Adding an Operational Store ................................................................................. 37 

Working with Data & Information ........................................................................... 38 

Adding a Source ............................................................................................... 38 

Adding a hub .................................................................................................... 40 

Appendix ............................................................................................................... 41 

Further Reading................................................................................................... 41 

S-EA-T homepage ................................................................................................ 41 

 

 

 



S-EA-T User Guide 

 

5 

 

Installing S-EA-T 
S-EA-T is installable from the media on which you receive the product or is downloadable 
from the S-EA-T.com website.  

To install the software: 

1. Insert the media on which the software is located into your computer‟s drive.  

2. Selecting the file named S-EA-Tv0.1 Windows Installer will invoke the Setup 

Wizard. 

3. The SEAT Setup Wizard invokes and guides you through the installation, as 

depicted in diagram below; 

 

Figure 1 S-EA-T Setup Wizard 

Once S-EA-T has installed, a shortcut icon is displayed on your desktop as depicted 
below; 

 

Figure 2 S-EA-T Icon placed on Desktop 

Double-click the icon to start the software. 

http://www.s-ea-t.com/
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Getting Started with S-EA-T 
When you start S-EA-T, the grid is displayed as greyed out, although it is empty as you 
need to create a new project, or open a previously saved project in order to start work.  

Understanding the User Interface 

The S-EA-T grid is effectively the tool‟s home and navigational page. It offers you an at-a-
glace status of your Enterprise and corresponds with the concepts described in the 
Enterprise Architecture Stack. 

Refer to the S-EA-T Concepts Guide for further information on the Enterprise Architecture 
Stack and how this maps to the S-EA-T Grid. 

The Grid 

The S-EA-T grid provides you with a three-dimensional, overall view of the state of the 
Enterprise and from the grid you can navigate directly to the current area of focus, 

whether it be Business Operating Model, Business Process, Application, Data and 

Information or Infrastructure. These areas in turn can be viewed in three core separate 
timeframes, Current, Transitional and Target. 

Note: In the current Academic version, the Transitional and Target timeframes have 
limited functionality. The primary reason for their inclusion in this version is to encourage 
the user to think about how the view of the Enterprise may change over medium to long 
timeframes. 

 

The Grid 

You can move the cursor over each area of the grid in order to display a description of the 

representation contained within. Click on an area to move to the selected view. 

Some areas are greyed-out, for example the Application Transitional View and all views 
within the Infrastructure area. This means that they are only supported by the S-EA-T Lite 
and future Enterprise version of S-EA-T. Refer to www.s-ea-t.com for further information. 

  

http://www.s-ea-t.com/
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Moving from Current through Transitional to Target 

S-EA-T supports representation of three separate timeframes. The Current view 
represents a point in time in the present. The Target view represents the Goal position to 

which we aspire and the Transitional view represents the gap between where we are 
today and where we want to be. 

The Current and Target views have fixed „time points,‟ whereas the transitional may well 
have multiple representations which are spread over several different timeframes where 
multiple views are associated with the state changes. 

Note: In the current Academic view the functionality available in the Transitional and 
Target views is limited. 

Understanding the Red-Amber-Green (RAG) key 

You can change the status of different areas of the grid to provide an at-a-glace view of 
the current status of the Enterprise. In both S-EA-T lite & the Enterprise versions, the grid 
changes automatically to display the status that you have set in the individual views. In 
the Academic version, you can manually change the status so that you can use the grid as 

a communication tool. 

To change the status of an area of the grid: 

1. Right click in the area that you want to change. A pop-up menu is displayed:

 

Setting the RAG status 

2. Select the required status that you want to represent. The icons on the grid 

change colour according to the key, to indicate the currently-selected status. 

Navigating S-EA-T 

You navigate through S-EA-T from the gird, clicking on the area with which you want to 
work. Each area has a navigational icon which you can use to move around the work areas 

of the tool. 

 

The Home button 

Moving around the views 

You move from the Current view, through the Transitional View to the Target View by 
clicking on the green right arrow.  

Returning to the grid 

You can return to the grid at any time by clicking on the Home button. Remember to save 
your work in the current view before returning back to the grid. 
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The View Options 

The options available under the View menu to show or hide rollovers and to toggle 
between the different time frames have been disabled in the Academic version.  

Managing Projects 

All of the work that you do using S-EA-T is contained in a project. S-EA-T is supplied with a 
Tutorial project that illustrates the key functionality of the system and contains a number 
of basic items. 

Creating a new Project 

When you create a new project, a directory with the specified project name is created in 
the required location. The S-EA-T project file is located in this directory also. 

To create a new project: 

1. From the File menu, choose New. The Save Project dialog is displayed.  

2. Select a location and specify a filename for your project. 

3. Click Save. The project is saved in the required location. 

Opening an existing Project 

To open an existing project: 

1. From the File menu, choose Open. The Open Project dialog is displayed. 

2. Browse for the location and filename of your project. 

3. Click Open. The project is open in S-EA-T. 

Working with the Sample Project 

S-EA-T is supplied with a sample tutorial project. The tutorial project contains an example 
of each item that you can maintain in S-EA-T, and illustrates how the items can be linked 
in the different views. 

Saving your work 

You need to save your work regularly. When you add an item, you should save your 
project before moving onto the next area. To save a project: 

1. From the File menu, choose Save 

2. To save the project under a different name, from the File menu, choose Save As.. 

and specify a name and location under which to save the project. 

Printing items 

S-EA-T allows you to produce reports on your project. In the Academic version, this 
includes printing a list of items by their type. You need to have a printer installed on your 
machine in order to print items. 

Note: The Export and Graph options are disabled in this Academic version 

To print a list of items: 

1. From the Reporting menu, choose Print. From the subsequent drop down menu, 

select the item type that you want to print. For Principles, Standards and Policies, 

you can print a list of items with which they are associated. 

2. A list of items of the selected type is printed. 

Registering S-EA-T 

You have the option to register S-EA-T. This will ensure you receive information regarding 

updates and will remove the unregistered banner from the top of the screen. To register S-
EA-T: 
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1. From the Options menu, choose Register. The Registration dialog is displayed 

 

The Registration dialog 

2. Enter your details in the dialog and click Register to register the product or click 

Send to post the form to http://www.s-ea-t.com 

http://www.s-ea-t.com/
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Working with Basic items 
S-EA-T supports the concept of basic items which are utilised throughout the tool. These 
are: 

 Architectural Principles 

 Stakeholders 

 Strategic Themes 

 Standards 

 Policies 

 Service Catalogue 

S-EA-T is supplied with a number of default basic items. You can add to these, but you 
cannot delete them. 

Managing Architectural Principles 

Architectural Principles define the underlying general rules and guidelines for the use of all 

IT resources and assets across the enterprise. 

To define a new Principle: 

Select the Principles button from the grid. The Principles dialog is displayed: 

 

The Principles dialog 

A list of currently-defined Principles is displayed on the right of the dialog. 

1. Click New 

2. In the Name field, enter a new name for this Architectural Principle. 

3. Type a meaningful description for the Principle. 

4. Check one or more of the Applies to boxes to indicate to which Architectural Layer 

the Principle applies. 

5. Click Save to save the Principle. If you are defining more than one Principle at this 

time, you must click Save before clicking New again or you will lose the Principle 

details you have just defined. 

6. Click New to define another Principle or click Close to close the dialog. 

  



S-EA-T User Guide 

 

11 

 

Managing Stakeholders 

Stakeholders can be anyone with an interest in the business or anyone who is affected by 
the actions of the business as a whole. 

Stakeholders that you define can act as custodians of data, in the Data and Information 
view. 

To define a new Stakeholder: 

1. Select the Stakeholders button from the grid. The Stakeholders dialog is displayed: 

 

The Stakeholders dialog 

A list of currently-defined Stakeholders is displayed on the right of the dialog. 

2. Click New 

3. Enter a First Name and Last Name for the Stakeholder. 

4. If required, enter further details for the Stakeholder, Job Role, Department, 

Extension, Employee ID, Employee Type. 

5. You can also select a Business Unit for the Stakeholder. Business Units are 

defined in the Operational Model 

Refer to page <insert page ref> for further information on defining a Business Unit. 

6. Click Save to save the Stakeholder. If you are defining more than one Stakeholder 

at this time, you must click Save before clicking New again or you will lose the 

Stakeholder details you have just defined. 

7. Click New to define another Stakeholder or click Close to close the dialog. 
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Managing Strategic Themes 

Strategic Themes basically set the direction in which the business wants to go and 
describes the goals that it wants to achieve. 

To define a new Strategic Theme: 

1. Select the Strategic Themes button from the grid. The Strategic Themes dialog is 

displayed:  

 

The Strategic Themes dialog 

A list of currently-defined Strategic Themes is displayed on the right of the dialog. 
2. Click New 

3. In the Strategy field, enter a name for the Strategy. 

4. In the Domain field, specify the domain to which the strategy applies.  
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5. In the Business Unit drop down list, select the Business Unit to which the 

Strategy relates. Business Units are defined in the Operational Model 

Refer to page 19 for further information on defining a Business Unit. 

6. You can now specify a number of keywords that will help you identify and ascertain 

the strategy. Keywords already defined are displayed in the Available column. 

You can also click the Add keyword button to define a new keyword at this point. 

 

The Add Keyword dialog 

7. Enter a new Keyword and click OK. The Keyword is displayed in the Available list 

ready for you to select it if required. 

8. To select an available Keyword to assign to this strategy, click on the Keyword and 

click Add to move it from the Available list to the Assigned list. 

9. If required, enter a Comment concerning the Strategy. 

10. In the Impact section, select the architectural area that your strategy affects. This 

is designed to help you consider how you should align your available technology 

with your current strategy. 

11. If required, assign a Maturity Rating to the Strategy. 

12. Click Save to save the Strategy. If you are defining more than one Strategy at this 

time, you must click Save before clicking New again or you will lose the details 

you have just defined. 

13. Click New to define another Strategy or click Close to close the dialog. 
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Managing Standards 

Standards are settings which guide the business in methods of good practice. Standards 
can be internal to the business, can be industry wide or can be international. If you are 
defining an industrial or international standard, then you should specify the URL where the 
standard is described in full detail. 

1. To define a new Standard: 

Select the Standards button from the grid. The Standards dialog is displayed: 

The Standards dialog 

A list of currently-defined Standards is displayed on the right of the dialog. 

1. Click New 

2. In the Name field, enter a new name for this Standard. 

3. Type a meaningful description for the Standard. 

4. Check one or more of the Applies to boxes to indicate to which Architectural Layer 

the Standard applies. 

5. If you specify that the Standard is an Industry or International one, then the URL 

path is enabled and you should specify the website where the Standard is 

described. 

6. Click Save to save the standard. If you are defining more than one Standard at 

this time, you must click Save before clicking New again or you will lose the 

details you have just defined. 

7. Click New to define another standard or click Close to close the dialog. 
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Managing Policies 

Policies are rules or plans of action facilitating governance with which the business should 
apply in order to achieve its goals. 

To define a new Policy: 

1. Select the Policies button from the grid. The Policies dialog is displayed: 

The Policies dialog 

A list of currently-defined Policies is displayed on the right of the dialog. 

2. Click New 

3. In the Name field, enter a name for the Policy. 

4. Give the Policy a description. 

5. You can now assign one or more previously-defined Principles to the Policy. 

6. To select an available Principle to assign to this Policy, click on the Principle and 

click Add to move it from the available list to the assigned list. 

7. Select the architectural layer that your Policy affects.  

8. Click Save to save the Policy. If you are defining more than one Policy at this time, 

you must click Save before clicking New again or you will lose the details you 

have just defined. 

9. Click New to define another Policy or click Close to close the dialog. 
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Managing Service Catalogues 

A Service is provided by the business to which capabilities can be applied.  

Service can be classed as either Technical (Systems) or Business Services and are 
designed to be orchestrated to meet both tactical (point in time) or strategic timescales. 

To define a new Service: 

1. Select the Service Catalogue button from the grid. The Service Catalogue dialog is 

displayed: 

 

The Service Catalogue dialog 

A list of currently-defined Services is displayed on the right of the dialog. 

2. Click New 

3. In the Service Name field, enter a name for the Service. 

4. Enter a description for the Service. 

5. You can now assign a number of capabilities that will help you in strategic planning 

for the Service. At this point, you can add a new Capability, or you can select one 

previously defined in the Process model. 
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6. Capabilities already defined are displayed in the Available column. Click the Add 

Capability button to define a new one at this point. 

 

The Add New Capability dialog 

7. Enter a new name for the Capability.  

8. Specify its usage from the drop down list 

9. Click Save. The Capability is saved and is available to be assigned to the Service 

10. To select an available Capability to assign to this Service, click on it and click Add 

to move it from the Available list to the Assigned list. 

11. Select the architectural layer that your Service affects.  

12. Click Save to save the Service. If you are defining more than one Service at this 

time, you must click Save before clicking New again or you will lose the details 

you have just defined. 

13. Click New to define another Service or click Close to close the dialog. 
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Working with the Business Operating Model 
The Business Operating Model (BOM) area of S-EA-T enables you to capture and model the 
basic elements of your business.  

 

The BOM 

Understanding the BOM 

The BOM user interface is split into the following different sections: 

 Artefacts – a list of basic Artefacts that you can assign to the model 

 Organisational Context – area containing the Drivers and Business Units lists 

 The main view – the area into which you drag items in order to work with them. 

Use this area to model how the enterprise takes inbound items, works with these 

items and then pushes them out. 

 Description – displays the description of the BOM 

 Reporting Notes – shows the content of the currently-selected Note, if it is a 

Reporting Note and allows you to assign a Protective Marking to the note. 

 Drivers – displays a list of currently-defined Drivers 

 Business Units – displays a list of currently defined Business Units 

 BOM Navigation – allows you to navigate between Current, Transitional and 

Target views of the BOM, and click on Home to return to the grid 

 RAG Status – the current R-A-G status of the inbound or outbound view 

 Heat Map – allows you to assign an overall status to the BOM, for communication 

purposes. 

Working with items of Organisational Context? 

S-EA-T allows you to add items of Organisational Context which can then be applied to 
other items. The items of Organisational Context that are supported are: 
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 Drivers – Drivers are essentially those set of key factors which either act as a 

driver for change and or drive the business forward or support the fulfilment of a 

business objective. These can be defined as Strategic or Tactical. 

 Business Units – Business Units capture the basic elements of the business in 

order to define its function. 

 Notes – Notes are textual items that can be assigned to other areas throughout  

S-EA-T. You can define notes as Reporting Notes which means that they can be 

selected for printing in future versions of S-EA-T. 

Adding a Driver 

To add a driver: 

1. Double-click on the Drivers icon in the Organisational Context area. The Driver 

dialog is displayed. 

 

The Driver dialog 

2. Enter a name for the driver. 

3. Specify whether the driver is Private to the enterprise or Public; specify whether it 

is a Technical or Business driver and specify whether it is Strategic or Tactical. 

4. Click Save 

5. Once you have saved the Driver, it can be seen in the Drivers list to the right of 

the BOM screen and is now available for use. Drivers that are shown in blue are 

those defined as Strategic. Those in black have been defined as Tactical. 

Adding a Business Unit 

To add a Business Unit: 

1. Double-click on the Business Unit icon in the Organisational Context area. The 

Business Unit dialog is displayed. 

 

The Business Unit dialog 
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2. Enter a name for the Business Unit. 

3. Specify whether the Business Unit is wholly owned by the enterprise, is a 

Subsidiary or whether this classification is Not Applicable. 

4. Click Save 

5. Once you have saved the Business Unit, it can be seen in the Business Units list to 

the right of the BOM screen and is now available for use. Business Units that are 

shown in blue are those defined as Wholly Owned. Those in black have been 

defined as Subsidiary. 

Adding Notes 

Notes are textual items that can be added throughout S-EA-T. Notes can be given a 
protective marking to indicate their level of secrecy. If you specify a note to be a Reporting 
Note, then you can print it out in subsequent versions of S-EA-T. 

To add a Note: 

1. Click on the Note icon and drag it onto the area in the BOM where you want the 

note to apply. The Note dialog is displayed. 

 

The Note dialog 

2. In the text box, enter the text for the note. 

3. Specify a Protective Marking for the note from the drop down list. 

4. Check the Reporting Note box to indicate that this is a note on which you may 

want to report. 

5. Click Save. 

6. Once you have saved the Note as a reporting Note, it can be seen in the Reporting 

Notes list to the right of the BOM screen. 
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Changing colours in the BOM  

You can change the colour of the background windows in the Add Value, Consume, Mould 
and Hygienic sections of the BOM. To change the colours: 

1. Click on the  button. The Assign colour dialog is displayed. 

 

The Assign Colour dialog 

2. Select the area that you want to change and select a new colour assigned for that 

area. 

3. Click Save to assign the settings. 
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Working with Artefacts 

This section describes how you can work with items in the BOM, adding them to your 
model so that you can build up a picture of how your enterprise brings items in, acts on 
them, before pushing them out. 

You use the following items in the BOM to represent this: 

 Resources 

 Assets 

 Consultations 

 Items of Information. 

Working with Resources 

Resources can be added to the Inbound area of the BOM only, highlighting they are 
available to the Organisation. To add a resource: 

1. Click on the Resource icon and drag it into the Inbound area. The Resources 

dialog is displayed. 

 

The Resources dialog 

2. Enter a name for the Resource. 

3. From the drop down list, select whether the Resource is private to the 

organisation, or within the public domain. 

5. You can now specify a business Driver for the Resource. You can select a 

previously-defined Driver or you can click on the  icon in order to add a new 

Driver. If you add a new one, you will still need to select it from the list. 

Refer to page 19 for further information on adding a new Driver. 

6. You can now specify a Business Unit for the Resource. You can select a previously-

defined Business Unit from the drop down list, or you can click on the  icon in 

order to add a new Business Unit. If you add a new one, you will still need to select 

it from the list. 

Refer to page 19 for further information on adding a new Business Unit. 
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7. Assign a Protective Marking to the Resource. This will affect the process 

downstream, for example, any process that is connected with a Secret Resource, 

will in itself be Secret. 

8. Specify the action that is performed on the Resource, for example, do we add 

value to this Resource before pushing it out, do we consume it? 

9. Click Save to save the resource. 

Once the Resource is saved, it is displayed in the appropriate section of the BOM. If you 
move the cursor over the Resource, its name is displayed in a pop-up. Resources that have 

been “consumed” are greyed-out as they can no longer be used to add value. 

You can now further specify how the resource is utilised by the organisation. This describes 
how the resource is being pushed out of the organisation. The interface for this is slightly 
different, depending on whether the Resource Adds Value and is Moulded as these 
Resources can be specified as “Push Internal”, which is performed while the resource is still 
within the organisation. For Consumed and Hygienic Resources, you only need to specify 
the “Push External” action. 

The first step is to review the Driver, Business Unit and Protective Marking assigned to the 
Resource: 

 

 

Resources that Add Value and are Moulded 

10. If appropriate, specify the Push Internal action performed, then in the Push 

External section, specify whether the resource is pushed to a 3rd party and if so, 

whether this is a Private or Public agreement. 
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11. You can now assign a number of Processes to the Resource. At this point, you can 

add a new Process, or you can select one previously defined in the Process model. 

Refer to page 27 for further information on how to define and work with Processes in the 
Process Model. 

12. Processes already defined are displayed in the Available column. Click the New 

Process button to define a new one at this point. 

 

The New Process dialog 

11. Enter a new name for the Process and click Ok.  

12. To select an available Process to assign to this Resource, click on it and click Add 

to move it from the Available list to the Assigned list. 

13. Click Save to save the Resource. 

Once a Resource has been Pushed out, it can be seen in the Outbound Section of the BOM. 
A different icon is displayed, depending on whether the resource is Private or Public. Once 
a Resource has been pushed out, its icon changes and it is no longer available for further 
editing. 

Working with Assets 

The process for adding and working with Assets is very similar to that for adding 
Resources. You drag the Asset icon into the BOM in the same way and similarly select 
properties for them: 

 

The Asset dialog 
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Working with Consultations 

The process for adding and working with Consultation items is very similar to that of 
adding Resources. You drag the icon onto the BOM in the same way and similarly select 

properties for them: 

 

The Consultation dialog 

Working with items of Information 

The process for adding and working with Consultation items is very similar to that of 
adding Resources. You drag the icon onto the BOM in the same way and similarly select 
properties for them: 

 

The Information dialog 

Note: User defined items are not available in this initial release. 
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Displaying BOM traceability 

The S-EA-T BOM provides you with an audit / traceability matrix allowing you to view all 
items within the BOM in grid format and see where this item is Pulled from and Pushed to, 
giving you a comprehensive audit trail. 

To display the BOM traceability: 

1. Click on the Trace button at the bottom of the screen. The BOM Traceability Table 

is displayed: 

 

The BOM Traceability Table 

Note: The Graphical view is not available in this edition nor is printing of table. 
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Working with Business Processes 
The S-EA-T Process view allows you to work with high level Business Processes. 

 

The Business Process view 

Processes that you have created previously in the BOM are displayed in the left of the 

screen. You can now drag them into the workspace in order to edit them and work on 
them further. 

Refer to page 24 for further information of where you create processes in the BOM. 

Working with items of Process Context 

You can define items of Process Context to use within the Process view. This includes: 

 BPCM – Business Process Compliance Management captures all regulations that 

can apply to an organisation and individual processes. 

 Notes – The Notes facility in the Process View is the same as that in the BOM. 

Refer to page 20 for further information on how to define Notes. 

Defining BPCM items 

To define BPCM items: 

1. Double-click on the BPCM icon under the Process Context section. The BPCM 

dialog is displayed. 
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The BPCM dialog 

2. Specify the name of the regulation and the year it was established or entered the 

statute books. 

3. Enter the country to which the regulation applies and provide a description. 

4. Click Save. The regulation you have added is displayed in the regulations section 

of the Process View. 

Working with Processes 

When you work with processes, you can add new ones, or you can work with previously 
added ones. You need to Modify a process before you can work with it. 

To work with Processes: 

1. Click on a previously-added process that you want to work with and drag it into the 

Process View. 

2. Click Modify Process button. The Modify Process Details dialog is displayed: 
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The Modify Process Detail dialog 

3. Alternatively, if you did not add any processes in the BOM, click the Add Process 

button to add a new process at this point. The dialog to add a new process is the 

same as that to modify an existing one, except that you need to assign it a Name 

at this point. 

4. Give the process a Description. 

5. In the Trigger section, specify whether this process is triggered by an event or by 

another process. If it is another process that is the trigger, then you can select 

from all available processes in the list on the right. 

6. From the Domain of Execution list, specify whether the process is executed 

internally to or externally from the organisation. 

7. From the Process Type list, specify whether this is an automated or manual 

process. If the process is automated, then it can be mapped to a system. 

8. From the BPCM list, select the Business Process Compliance Management 

regulations that apply to this process. The BPCM list is populated by the default 

ones supplied with S-EA-T, not those you may have added as part of the Process 

Context data. 
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9. From the BP Measure list, select the measure by which this Process is evaluated. 

This allows you to apply a value to the process in future versions of S-EA-T. 

10. In the Business Units list, select those Business Units to which the Process 

applies. 

11. Click Save to save the details you have added. 

When you re-introduce the process into the process view, you can no longer modify it. 

When you re-display a modified process in the process view, you can see that if the 
process is triggered by another process, this is now displayed: 

 

A process triggered by another process 
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Adding a Sub Process 

Once you have added a process, you can associate up to 7 sub-processes with it.  

To associate a sub-process: 

1. Click on the process that you want to associate with a sub-process. 

2. Click on the Add Sub Process button. The New Sub Process dialog is displayed: 

 

New Sub Process 

3. Enter a Name and Description for the sub-process. 

4. You can now associate a number of other Processes to the Process. At this point, 

you can add a new Process, or you can select one previously defined in the Process 

model. 

5. Processes already defined are displayed in the Available column. Click the New 

Process button to define a new one at this point. The Add New Process dialog is 

displayed enabling you to add details for the new sub-.process. 

6. To select an available Process to assign to this Resource, click on it and click Add 

to move it from the Available list to the Assigned list. 
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7. You can now associate a number Capabilities to the Process. Capabilities already 

defined in the Service Catalogue are displayed in the Available column. 

Refer to page 16 for further information on adding Capabilities in the Service Catalogue. 

8. To select an available Capability to assign to this Process, click on it and click Add 

to move it from the Available list to the Assigned list. 

9. Click Save to save this new sub-process. 

When you return to the Process View, you can see in the Process swim lane at the 
bottom of the screen, that the sub-process is shown. Additionally, if any capabilities 
have been assigned to the Process, they are shown in the Assigned Capabilities 
section of the Process view. 

 

The Process Swim Lane 

You can define up to 7 Sub-Processes for each process. If you click on a Sub-Process in the 
swim lane, then the Sub-Process properties dialog are displayed, allowing you to edit 
associated Sub-Processes and Capabilities. 

Additionally, the Process Associations section of the Process View builds up to display 
the processes to which you have associated sub-processes.  

 

The Process Associations section 

To clear the Process View, click within the view and select Clear from the context menu 
displayed. This does not clear the Process Associations section. 
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Working with the Application Portfolio 
You use the Application Portfolio to define the applications that support your organisation. 
This additionally helps build up the mapping between processes and applications. 

 

The Application Portfolio 

The Application lists applications once you add them. 

Adding an application to the portfolio 

To add an application: 

1. Click the New application button at the bottom of the screen. The New 

Application dialog is displayed. 
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The New application dialog 

2. Enter the name of the application. 

3. Specify the technology on which the application is based. 

4. Specify whether or not this is an commercial off the shelf (COTS) software. 

5. Specify whether the application has been customised. 

6. Provide a view of the application‟s value for money. 

7. Give an approximate annual total cost of ownership (TCO) for the application. 

8. Specify whether or not the application should be in the target application model. 

9. Click Save when you have completed the dialog. The application is displayed on a 

new row in the Application Portfolio view. You can now assign further information 

to the application. 

Assigning further information to an application 

You can move through the columns of the application grid assigning further information for 
the application. This includes assigning Processes and Principles that the application 
supports, as well as specifying new Operational Stores. 

To assign further information to the application: 

1. Position the cursor at the point in the application grid where you want to specify 

further information. Where a cell appears to be greyed out, this indicates that 

there is a further dialog for you to specify information. For example, to assign 

processes that the application would support, click in the Process cell. 

 

The Application Portfolio grid 

2. The Application – Process Mapping dialog is displayed. 
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Application – Process Mapping dialog 

3. Select the processes that you want to assign to this application and click Add to 

move them to the Assigned Process column 

4. Click Save when you are complete. 

Adding an Operational Store 

An Operational Store should not be aligned with a database and it could represent a group 

of databases. You can also add Operational Stores in the Data & Information View. 

To add an Operational Store: 

1. Click on the Operational Store button at the bottom of the Application Portfolio 

view. The New Operational Store dialog is displayed. 

 

The Operational Store dialog with the drop down menus displayed 

2. Enter a name for the operational store. 

3. Select the type of data that is contained in the store. 

4. Select the data use, whether many people use it for collaborative purposes, 

analytical “what-if” scenario purposes, or as an information store. 
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5. Select the protective marking that the operation store should be assigned. 

6. Click Save when you are complete. 

You can now select the Operational Store when you are specifying further details for the 
Application. 

The Generate ARM (Application Reference Model) functionality is not available in this 
version of S-EA-T, although you can use the Print button to print a view of the Application 

Portfolio. 

You can work with the current and target views of the Application Portfolio. The 
Transitional View is not available. 
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Working with the Data and Information View 
The Data and Information view is available in the current view only. This offers a 
technology-independent view of the data & Information in your organisation. 

 

The Data & Information view 

Working with items of Data & Information Context 

You can define items of Data & Information Context to use within the Data & Information 
view. This includes: 

 Custodian – This feature is not available in the Academic version of S-EA-T. 

 Notes – The Notes facility in the Data & Information View is the same as that in 

the BOM. 

Refer to page 20 for further information on how to define Notes. 

Adding an Operational Store 

You can add Operational stores in both the Application Portfolio View and the Data & 
Information view. The process is the same in both views. 

Refer to page 35 for further information on how to add an Operational Store. 
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Working with Data & Information 

Operational Stores that you have added are displayed in the Repository list on the left of 
the Data & Information view. Those which have been given a Protective Marking of Protect 
or above are additionally displayed in the Protected Files section as well. Standards and 
Principles that have already been specified are also displayed in the Data & Information 
view. 

 

Adding a Source 

To add a new data or Information source to the Link View: 

1. Right-click in the Link view pane and select Source  

 
2.  The New Source dialog is then displayed. 

 

The Import dialog for a New Source 

3. Enter a name for the source and click OK 

4. The Source is added to the Link View. Because it is a source of information, you 

can only import it to transform into a operational store which is done by selecting 

the Icon placed on the Link View Pane and right clicking on it.  

 

The connection dialog for a Data Sources 

 

 

5. Right click on the Source in the Link View and choose Import. 

6. Specify a name for the Import and click OK 

7. You can now see the Import in the Link view and you can assign an Operational 

Store to build up the view of how the information is used, as opposed to how it is 

built. 
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8. Right-click on the Import and select Operational Store. The New Operational 

Store dialog is displayed and you can add a new Operational Store. Once you 

return to the link view, you can see how your picture of your data and information 

use is being built up. 

 

The Link View showing how raw data is being used and stored 

You can also drag the repository that you want to work with from the Repository list into 
the Link View in order to work with it further, including specifying how data is exported 
from it. 

8. Right-click on the repository that you want to work with and choose Export. In the 

subsequent context menu, specify whether the repository exports to either and 

internal or external feed.  

9. You can then specify new external or external feeds and if it is an internal feed, 

create another Operational Store or 3rd party Destination for the data to be located 

in.  

 

Building up a view of the data & information flows 

10. You can also right-click on a repository to create an ETL, and subsequent 

operational store for this in the same way. 
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Adding a hub 

A hub takes in information and data feeds and redirects and pushes out again. It is 
connected to one or many Operational Stores. 

To add a hub: 

1. Right click in the Link View and select Hub from the context menu.  

2. Enter a name for the Hub. 

3. You can now connect the hub to an Operational Store and a Data Source.  

4. Right click on the hub and select Connect Operational Store or Connect 

Imported Source according to you required action. 

5. A list of either Stores or Sources is displayed and again, you can select the 

required item in order to build up a picture of how the data is used. 

To clear the Link view in order to work with another repository, right click in the view and 
select Clear. 
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Appendix 

Further Reading 

The following are strongly recommended as reading prior to software usage; 

1. Simple Enterprise - Architecture Toolset (S-EA-T) Concepts – Daljit Banger , May 

2010 available at S-EA-T.com  

S-EA-T homepage  

 

Ref 
Number 

Description 

1 Architectural Principles Button 

2 Stakeholder Definition Button 

3 Strategic Themes Button 

4 Architectural Standards Button 

5 Systems and Organisational Policies Button 

6 Services Catalogue definition Button  

7 S-EA-T lite / Enterprise Features not available in Academic Version. 

8 Red Amber Green (RAG) Status key 

9 Current Open Project File Name 

10 – 12  Business Operating Model (Current, Transitional & Target) 

13 - 15 Business Processes  (Current, Transitional & Target) 

16 /18 Application Portfolio View (current & Target) 

17  Feature Not Available in Academic Version 

19 Data & Information (Current) Views  

20 – 24 Feature Not Available in Academic Version 
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For further information on S-EA-T any of the above visit http://www.s-ea-t.com 
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